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❖ Introduction 

 

After many years, in 2024 we have finally succeeded in delivering the new version earlier in 

the year as well as moving the user meeting forward. The aim is to move that even closer 

to start of the year and into the first quarter. Release date depends on region. 

In previous years, this was not possible for various reasons. One reason for this is the fact 

that the cadwork group and the number of customers has grown considerably. Added to 

this is the need to have the product available in more and more languages. In recent years, 

the complete delivery of a new version in all countries could therefore only be completed in 

the fourth quarter of a year. 

 

Each country-specific delivery brings new customer feedback and entails additions to the 

development process, meaning that the entire development capacity cannot be available 

for the subsequent version from the start of delivery. The realization of all planned 

functionalities of the new version thus postponed the start of delivery to at least the second 

quarter. 

 

Since the delivery of version 30, only a short period of time has been available for further 

development, testing and documentation. We have therefore decided to provide a service 

pack for version 30 in 2024 rather than a master release. 

 

The functional scope of the service pack is less than in a master release. Nevertheless, 

there are a number of interesting new features, optimizations of existing functionalities and 

initial results on one of our core topics, the improvement of performance. 

 

The version available from February 2024 is 

called cadwork version 30 (SP2024). It is based 

on the version 30 database and is therefore 

backwards compatible with it and offers a high 

degree of stability thanks to the corrections and 

additions made in recent months. 

cadwork version 30 (SP2024) is not installed via 

a setup as usual but is installed automatically 

for every maintenance customer via the Live 

Update. There is also no need for you to adapt 

init and/or layout files. 
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This year's early delivery of the new version is also linked to objectives that will have a 

positive impact on the performance of our software in the medium and long term. 

As the chosen approach does not tie up the entire development capacity, we have already 

been able to work on the cadwork version for 2025 since summer 2023. The development 

cycle for this version will therefore be extended, giving us the opportunity to further 

modernize the core and work on medium and long-term projects. For example, the 

connection to our HOOPS graphics engine will be re-implemented and we will focus 

intensively on the important challenges of performance and stability. 

This version will be called cadwork version 2025 and will be released at the beginning of 

2025. 

 

Due to the approach described for this year, the focus of the user meetings will also be 

slightly different. Of course, there will be enough space for a detailed explanation of the 

new features in cadwork version 30 (SP2024). In addition, we will focus on functionalities 

that are not new, but are only known to a few customers or are not used to their full 

extent. And last but not least, we want to allow sufficient time to maintain the important 

personal exchange with our customers. 

 

We would like to take this opportunity to thank all our maintenance customers. The regular 

mutual exchange provides us with an important basis for practical further development. 

Your maintenance contributions ensure that we can continue to develop our products and 

provide you with a competent and committed support and training team in your day-to-day 

business. 

 

We would be delighted if you would continue to place your trust in us and hope that we will 

meet your requirements in terms of performance, quality and technical support at all times. 

 

We wish you a successful start to working with the new version. The following 

documentation should help you. In addition, a collection of videos on various topics will 

soon be available in cadwork version 30 (SP2024), which will be continuously expanded. Of 

course, we will also be happy to answer your questions personally. 

 

 

Your  team. 

  

https://www.youtube.com/@CadworkMontreal
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❖ 3D 

 

➢ General information 

 

▪ Update Graphic engine "Hoops Visualize" 

We use the "Hoops Visualize" library from Techsoft to display the design in cadwork 

3D. The library enables us to display the design in 3D in an appealing and high-

performance way. Unfortunately, there were some performance problems in cadwork 

version 30, which we were able to resolve together with Techsoft last year. The 

performance in hidden line mode with dashed lines was so inadequate that the 3D file 

sometimes froze. With Service Pack 2024, you will receive an update that fixes these 

problems. 

 

▪ Update of the import library "Hoops Exchange" 

 

• Importing IFC files 

Techsoft supports us in importing IFC files with a library called "Hoops Exchange". 

We are now using the latest version of this library in Service Pack 2024, which can 

import large IFC files more quickly. The time gains are particularly large if many 

intersections have to be carried out due to the geometry description in the IFC file. 

As an example, we would like to mention IFC files that were output by "Tekla". 

Furthermore, in the latest "Hoops Exchange" library, the reliability and tolerance of 

faulty and "unclean" IFC files has been improved. Customers who frequently receive 

IFC files from various third-party programs know that the quality of the data is often 

not sufficient to read them into cadwork 3D. "Hoops Exchange" is looking for ways 

to read the "unclean" IFC files anyway, so that they can at least be used as a 

visualization in cadwork 3D. 

 

• Importing SketchUp files 

With the update of "Hoops Exchange", the import of SketchUp files in 2023 format is 

supported. In the last version, you could only import files up to the 2021 format. 
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▪ Calculation time of the wall shop drawing export 

For Service Pack 2024, we have focused a great deal of attention on the performance 

of the wall shop drawing export. Especially exports from projects with a high level of 

detail and many drillings, connector axes and/or MEP axes repeatedly lead to long 

export times. 

For this reason, we have examined these exports in detail and implemented various 

conversion measures and optimizations that lead to a significant acceleration of export 

times. The more complex the project, the greater the time saving. Nevertheless, the 

speed advantage also has a positive effect on smaller projects. 

For future versions, we will continue along this path and focus a large part of our 

attention on optimizing and accelerating exports in order to further reduce export times 

significantly. 

 

▪ Revision of the connector axis drilling visualization 

For Service Pack 2024, the visualization of the drillings of connector axes (CA) has been 

revised. This revision means that the holes of the CA are now rendered much faster. 

Especially for drillings that are cut off at an angle, only around a third of the time 

should be required for rendering. This means that files with many diagonally cut CA 

drillings in particular should now start up much faster.  
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▪ Starting up version 15 

Up to and including cadwork version 15, a binary file format was used for sequential 

reading and writing of all data. Since version 16, an SQL database has been used to 

store the design data. This is a modern form of data storage that enables flexible 

expansion, offers greater data security and ensures permanent access to all data during 

program runtime. 

 

Due to this change, 3D files from 

version 15 or older had to be converted 

for loss-free data transfer. For this 

purpose, a converter was installed 

upstream when importing such a file. 

The continuous further development of 

the database also requires further 

development of the converter. 

 

 

 

 

 

As the import of 3D files from version 15 or older is required less and less frequently, 

the adaptation of the converter has been discontinued from version 30 (SP2024). 

Therefore, only files from version 16 can be imported from now on. When attempting 

to import older files with cadwork 3D (SP2024), a corresponding message will appear. 

Older files must first be started and saved with an older version (e.g. cadwork 3D 

version 29).  

The file cannot be opened. It is probably a file that is no longer 
supported by this current version. 
Please try to open the file with cadwork V29 or lower. 

The file cannot be opened 
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➢ Windows/Top menubar 

 

▪ File -> Settings... 

With the Service Pack 2024, the new Overwrite all settings import option is available in 

the Import settings dialog.  

The Overwrite unused settings import option, which was already available in previous 

versions, first deletes the existing settings from the 3D file and then imports all settings 

from the selected file.  

Settings that are already in use are neither deleted nor changed with this option.  

The new settings import option Overwrite all also deletes the existing settings from the 

3D file and then imports the settings from the other file.  

The settings that are in use are also overwritten with this option. This means that it is 

subsequently possible to completely adopt the settings from another file and apply 

them to the entire project.  

This option is currently only available for material data. It is planned to extend this to 

the other settings in the next versions.  
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▪ File -> Import… 

News on importing files is documented in the Right menu section under Add -> Files.... 

News on importing IFC files can be found in the IFC section. 

News on importing Point clouds can be found in the Point cloud section. 

 

▪ File -> Export… 

The latest news on exporting files is documented in the Right menu section under 

Export -> Files.... 

News on exporting IFC files can be found in the IFC section. 

 

▪ Edit -> Activate all <Ctrl+A> 

 

• Info window 

This function can be used to activate all elements or 

elements with special properties very quickly. As with 

every activation process, the info area in the bottom 

right-hand corner is then updated with the 

information on the active components. If not all item 

properties have been calculated in advance, there 

may be a noticeable delay before further processing is 

possible, if there are a large number of active items. 

This time span has been shortened in the service 

pack, making it possible to work more smoothly. 

 

It was also possible to achieve a speed advantage in 

large files if there are many items with the same item 

or production number. The calculation time for the 

number of active items with same item or production 

number has been significantly reduced. 
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• Shortcut key <Ctrl+E> - "All element module output settings (Ctrl + E dialog)” 

In Service Pack 2024, the output settings available in the Element module dialog 

(Ctrl+E dialog) are grouped together. The entire group can be activated with the 

new option All element module output settings (Ctrl+E dialog).  

In addition, the previously missing output setting "Show attributes" can be taken into 

account with the option Same settings for “Show attributes”. 

This makes it possible to activate elements with identical output settings for the wall 

shop drawing export. 
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▪ Window -> Display filter 

The + and - buttons are available for 

the element type filter to quickly 

select or deselect all element types. 

The position of these is now fixed so 

that both buttons are displayed even 

in small window sizes with an active 

scroll area. 

 

 

 

 

 

 

 

 

▪ Tools -> Configuration "Ctrl+J" 

The clipping box is now available as a 

new special element for fading in or 

out using the <Ctrl+J> key 

combination. The clipping box makes 

it easier to work with point clouds. 
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▪ Tools -> Hoisting 

The SP2024 provides you with the hoisting function. This 

function enables the automated calculation of lifting points 

and assignment of machining operations for lifting devices 

in timber framed walls, floors and roof panels. 

 

 

 

 

A Light wall and a Heavy wall option are available. The Light wall option places the 

lifting points in the top plate as example for mechanical lifting anchors whereas the 

Heavy wall option additionally uses the studs to spread the lifting load onto the panels. 

An example here would be lifting slings. 
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• General 

All settings that can be defined independently of the wall type are defined in this tab: 

 

 Wall differentiation by 

As usual in cadwork, the walls, roof or floor panels 

are defined as a group or a subgroup with a wall 

rough volume. The rough volume axis alignment 

plays a decisive role in referencing, which is required 

to calculate the lifting point positions. The lifting 

points you define are distributed according to the 

materials centre of gravity. 

 

 

 Attributes of created components 

 Color: 

Color that the created lifting point components 

(Drilling axes, connecter axes, markings,…) are 

getting assigned. 

 Name: 

Name that is assigned to the generated lifting point 

components. 

 

 

 Name of top reference parts 

When calculating the lifting points, it is essential that 

reference parts are defined. Those top reference 

parts are used for lifting point placement. These parts 

serve as the basis for the positioning of machining 

operations for lifting points such as drilling axes, 

connector axes and end-types. Defining the reference 

parts ensures that the machining operations are 

carried out in the correct places. 

 

 Weight limit 

Limit value for determining whether a wall is 

considered as "Light wall" or "Heavy wall". This 

differentiation is mainly used to assign the two option 

of lifting point configuration - top plate fixing only or 

use of stud to spread the load. 
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• Hoisting calculation 

This dialog component is displayed on all three tabs (General, Light wall and Heavy 

wall) in the “Hoisting” dialog so that the calculation can be started at any time. 

Use the Light, Heavy and All buttons to start the respective calculation for all active 

walls. 

 

• Light wall 

All walls below the entered weight limit are classified as "Light wall" and their lifting 

point calculation is carried out using the configuration in this tab. 
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 Lifting points 

You can use the + and - buttons to add or remove additional lifting 

points.  

You must specify an offset for each additional lifting point. The offset is always 

calculated from the centre of gravity in the positive and negative axis direction. 

 

 Processes in top reference part  

If the Make position correction checkbox is selected, an attempt is made to position 

the lifting point without colliding with the studs. Otherwise, the exact offset 

specified is used for positioning. A position correction is only made in the direction 

of the longitudinal axis of the wall. 

 

The element capable of creating a process is generated during the calculation 

according to the active selection. Drilling axes with the defined diameter, connector 

axes previously added to standard element library as standard connector axis or 

end-types of the type "Lengthening" are available for selection. 

Lifting point positions can be generated either horizontally or vertically for the type 

“Light wall”. The prerequisite is that top reference parts can be determined in these 

directions. Vertical lifting point positioning is not possible for the type “Heavy wall”. 
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• Heavy wall 

For walls that are heavier than the weight limit entered, the calculation is carried out 

using the configuration in the Heavy wall tab. Lifting point positions can also be 

added here and their offsets defined. In contrast to light walls, the position 

correction is always carried out. Standard connector axes or drilling axes can be 

calculated in the selected top reference part. 

 

 Number of drillings 

It is specified whether one or two drillings 

are to be drilled to accommodate the 

lifting device. For a single hole, this is 

positioned on the pull side of the handle.  

If two holes are drilled, these are 

positioned to the left and right of the 

identified stud.  

In addition, holes or mortises are created 

in the vertical stud by the selected end-

type, through which a sling can then be 

pulled. 
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• Hoisting calculation 

The Light, Heavy or All buttons are used to calculate the lifting points for the active 

walls, taking their weight classification into account. 

 

After the calculation, a calculation report is displayed. 

The components created by the hoisting function were added to the walls with the 

properties set under General -> Attributes of created components. 
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• Lifting point examples, possible calculation results 

 

 Light wall with 15 mm lengthening 

(End-type), horizontal distribution of 

lifting points, processes in top 

reference part with name “Top plate”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Heavy wall with two drilling axes 

through the top reference part named 

"Top plate". The sling hole through the 

stud is generated with use of an end-

type. 
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▪ Script-populated attributes   

The script-populated attributes introduced in version 29 are becoming increasingly 

popular. 

Especially when developing a script-populated attribute, it is often necessary to adapt 

and correct the script used. To do this, it is necessary to open the Attribute manager 

dialog under Userprofile (user’s settings) -> Timber… -> Attributes, switch to the Auto 

populate tab and update the corresponding script using the   button.  

To simplify this process, the Script-populated attributes dialog has been revised and the 

Script populated attributes configuration section has been added. This makes it possible 

to switch directly to the Auto populate -> Configuration tab in the Attribute manager 

dialog and update the corresponding script or create new scripts. 
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➢ Status bar 

 

▪ Attributes display 

The following new attributes are now available for the attribute display: 

• Panel thickness real 

• Panel thickness rough 

• Panel format (LxWxT) real 

• Panel format (LxWxT) rough 
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➢ Left menu 

 

▪ Configuration of the Graphics options 

• Expert mode -> 3D mouse 

The integration of SpaceMouse devices from 

3Dconnexion has been improved with Service Pack 

2024. 

These improvements are currently being reviewed by 

the manufacturer 3Dconnexion. After successful 

testing and review, cadwork 3D is a certified software 

for 3Dconnexion 3D mouse. The certification will be 

completed in the next few weeks. 

 

In order to use a SpaceMouse in cadwork, it must be activated once in the Expert 

mode tab of the 3D - Graphics options dialog: 
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All other settings for the 3D mouse are made in the 3DxWare driver of the mouse. 

This requires the mouse to be connected and the latest 3DxWare software from 

3Dconnexion to be installed. 

 

The following changes have been integrated in this area: 

 New representation of the rotation point  

We now use the symbol provided by 3Dconnexion for the rotation point instead of 

a generic point marker.  

The new rotation point icon is a small representation of the 

3Dconnexion logo.  

 

During rotation, the settings set in the 3Dconnexion driver are used: 

 

 Use selected item  

If this option is active, the rotation point is placed on the active point. If no point 

is active, the rotation point is placed in the middle of all active elements.  

If no elements are active or the option is not activated, the following applies: 

If all visible elements are in the image section, the rotation point is placed in the 

middle of the visible elements, otherwise the rotation point is placed on the first 

element in the middle of the image section.  



News Version 30 (SP2024) 

 

 

2
0

2
4

2
3

 -
 c

ad
w

o
rk

 3
D

 Navigation functions 

All navigation functions of the SpaceMouse are now supported.  

QuickZoom (zooms in/out to crosshair position), Fit (zooms to all visible elements), 

ISO views and saving and loading views in 3DxWare and many other functions are 

now also supported by cadwork 3D. 

 Compatibility 

The integration is only compatible with SpaceMouse devices from 3Dconnexion. 

Devices from other manufacturers are not supported. 

 

The 3D mouse is an additional operating option for cadwork 3D, but it never 

completely replaces a normal mouse and keyboard. 
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▪ Userprofile (user’s settings)-> Timber... -> End-types... -> Dovetail 

In some configurations the dovetail mortise must be enlarged so that a dovetail can be 

inserted into its counterpart. The dimensions required for this are usually only known 

on the machine. For this reason, the BTL, bvx and bvn machine interfaces provide the 

options "With pocket" and "Extended" for inserting the dovetail. 

These options can be found in cadwork in the end-type definitions under Modify -> 

Dovetail mortise -> Dovetail mortise execution. 

With the execution "Extended", the dovetail mortise is extended along the taper angle 

up to the top edge of the receiving part. Under certain circumstances this can lead to 

very long processing e.g. lintel to mullion connection. 

With the execution "With pocket", a rectangular pocket is milled out above the dovetail 

mortise just high enough for the dovetail to be inserted and slid into place. How high 

and wide this pocket is ultimately produced is decided by the respective CAM system. 

The dimensions of this installation pocket on top of the dovetail mortise can therefore 

not be displayed realistically in the viewer mode, in the shop drawing export and in the 

individual control under machine export.  

In cadwork, the height of the pocket corresponds to half its width. 
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▪ Userprofile (user’s settings)-> Timber... -> End types... -> Tenons 

For better usability, a new note has been added for the tenon in the end-type dialog. 

This message appears as soon as you have set that drilling axes are to be created that 

are not linked to the end-type. This is intended to reduce the risk of this option being 

set unintentionally. The advantage of non-coupled drilling axes is that they can also be 

modified in 3D afterwards, as they behave identically to drilling axes that have been 

created manually.  

The major disadvantage, however, is that the drilling axes do not react to any changes 

to the tenon. If the part with the tenon is moved, copied or deleted, for example, the 

drilling axes remain unaffected. If you are not aware of this, drilling axes can quickly 

remain in the wrong positions in the project and/or be missing in other places. If this 

only becomes apparent later, it is very difficult to clean up the project. To avoid this 

problem, it is recommended to work with linked drilling axes for the tenon. However, if 

you are aware of how the non-linked drilling axes behave, there is of course no reason 

not to use them.  
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➢ Right menu 

 

▪ Activate attribute -> Machine data  

The function Activate attribute-> Machine 

data activates all parts for which machine 

data has already been calculated. The 

settings button can be used to 

differentiate which processes the parts to 

be activated should contain. If parts are 

already active, calculated processes are 

switched on for these parts. parts are 

activated or deactivated by switching 

them on or off. In version 30 (SP2024) 

there is an additional setting Show 

reference side. If you activate this option, 

the machine processes calculated in the 

design are further subdivided into the 

determined machining reference sides. 

This information is helpful if accessibility is 

restricted during production, for example 

machining from below (Side 1) on a panel 

that cannot be turned. The colors and 

numbers (Side 1, Side 2, ...) of the 

displayed reference sides correspond to 

those in the individual control of the 

machine export. The designations 

(negative height, positive width, ...) refer 

to the local axis system of the parts.  
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▪ Add -> Axes... -> Connector axes 

The option introduced in version 28 to automatically determine the axis length in the 

2D plane using the keyboard option <E> Active elements is now active by default as 

soon as the function with active elements is called. 

 

The size of the connector axes dialog could previously only be adjusted at the bottom 

right-hand corner. Especially when working with multiple screens and different screen 

resolutions, it may not have been possible to reach this corner. The dialogs can now be 

resized across all edges and corners. This means that the size can be adjusted at any 

time, regardless of the current position of the dialog on the screen. 

▪   
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In order to be able to recognize possible collisions with the bolt at an early stage, 

wooden plugs are made slightly transparent. 

 

▪ Add -> Architecture -> Wall 

With cadwork version 30 (SP2024), this menu item is displayed in 

purple. This means that this menu item will be removed in future 

versions. In the future, the use of multilayer walls will be changed. 

It is already possible to convert 2dc walls into multilayer walls. 

The "Import" option is available for this purpose in the 

configuration dialog for multilayer walls. 
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▪ Add -> Architecture -> Multilayer wall 

Refinements have been made to the "Multilayer walls" introduced in version 30. This 

affects the display of multilayer walls in cadwork 3D as well as working with the dialog 

for defining multilayer walls. 

Previously, the wall layers in the wall rough volume were displayed as planes. 

 

From Service Pack 2024, each layer is displayed as a volume. The transparency defined 

for the wall rough volume also affects the display of the wall layers. 

If wall layers are shown, they are displayed in the set transparency and the wall rough 

volume is displayed completely transparent. If wall layers are hidden, the wall rough 

volume is displayed with the set transparency.  

Version 30 (SP2024) 
without transparency 

Version 30 without 
transparency 

Version 30 (SP2024) 
with transparency 
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The changes in the dialog affect the behaviour of the left-hand area in which the list of 

existing multilayer walls is displayed. Two improvements have been made here. 

 

When copying multilayer walls from 3D File to UserProfil via "drag and drop", it was 

previously the case that the wall had to be dragged exactly to the UserProfil or to a 

folder in the UserProfil when moving it. 

This has been adjusted for easier handling. The mouse button can now be released at 

any point in the UserProfil tree. The copy in the UserProfil is created exactly at this 

point in the UserProfil.  
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Furthermore, it was previously the case that when a new folder was created, it was 

always created on the top level of the 3D file. Now, the active folder or active wall is 

always taken into account during creation and the new folder is created at the 

corresponding position. 

 

▪ Add -> Files... 

 

• IFC (*.ifc)... 

News on importing IFC files can be found in the IFC chapter.  

 

• Revit (*.rvt, *.rfa) 

Revit has again released a new version (Revit 2024) in 2023. We have expanded our 

interface so that we now support this version. This means that currently Revit 

versions 2014 to 2024 can be imported. 
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We import Revit files in *.rvt and *.rfa format with the help of an external tool. We 

will provide the next Revit version, which is expected to be released in 2024, as soon 

as the external tool supports it. Based on our experience in recent years, we expect 

this to happen at beginning of 4th quarter in 2024. 

 

• Point cloud (*.pts, ...) 

News on importing Point clouds can be found in the Point cloud chapter. 

 

▪ Copy/Move -> Symmetry 

For each rendered representation, the different textures must be used correctly parallel 

and transverse to the wood grain. In some situations, the more complicated geometry 

of beam end profiles led to the longitudinal texture being displayed on end grain 

surfaces when moving and copying symmetrically. 

With the help of the updated "Hoops Visualize" graphic engine, we were able to 

eliminate this problem in Service Pack 2024. The end grain texture is also displayed for 

each end grain surface. 

  

Render with V30 

Render with V30 (SP2024) 
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▪ Modify -> Other attributes... 

Since the number of user attributes is no longer restricted, they are increasingly being 

used to structure the design. 

This means that the number of user attributes used is generally much higher than 10, 

as was previously possible.  

 

In Modify, up to version 30, a maximum of ten 

attributes were displayed in the list. To access 

the remaining attributes, the scrollbar that was 

then available had to be used. 

 

With service pack 2024, the entire available 

space in the right-hand menu is used to 

display defined user attributes. The space for 

the display depends on the screen resolution 

used. 

A scrollbar is only displayed if the number of 

user attributes used cannot be displayed in the 

available space. This can be used to access the 

other attributes. 
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The increased use of user attributes means that they need to be modified more often. 

An additional shortcut key has therefore been provided in 

Service Pack 2024 to enable quick access to the modification of 

user attributes.  

 

After modify has been called up via the <1> shortcut key, the 

<Ctrl+2> key combination can be used. 

 

 

 

 

The user is then at the top of the 

selection list of user attributes (user 

attribute 1). 

 

 

 

The attribute to be modified is 

quickly selected via a further 

keyboard entry. For example, 

entering <2> + <5> in quick 

succession places the cursor on user 

attribute 25. A (L) mouse click 

activates this attribute for 

modification. 
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▪ Export 

• Machine -> ... -> Individual control manager 

 Selective export of machine data 

In the individual control manager, it is 

possible to select several names within the 

tree, provided you are in the menu 

immediately before the machine individual 

control.  

To make a selection, hold down the <Ctrl> 

key while clicking on the individual names 

in the individual control manager with the 

left mouse button (L). 

Then right-click (R) to open the context 

menu. Select the new entry Export (only 

available after calculation) and the export 

dialog will open. 

The export that is then started will only 

transfer the selected items to the 

corresponding machine file. This makes it 

easy to transfer individual parts and 

groups independently of their sorting in 

the individual control manager. 

 

 Exported parts 

As soon as certain items have been 

exported to a machine file, the 

corresponding entries are marked with a 

green tick in the individual control 

manager. 

This marking can also be set or removed 

manually. To do this, you will find the 

entry Already exported? .  

If only a partial quantity of an item that 

contains several components has been 

exported, a grey check mark appears here, 

along with an indication of how many 

components of this item have already 

been exported.   
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• Machine -> ... -> Individual control / Individual control manager 

 Change component status 

To change the status of a component, you 

can now also click directly with the left 

mouse button (L) on the circular status 

symbol. This opens the selection menu for 

the various statuses such as Not 

calculated, Calculated, Checked with 

errors, Checked - no errors. If the 

processing check reports errors for a 

component, you can change the status to 

Checked - no errors after a successful 

visual inspection. 

 Shortcuts for calculated processes selected 

in the individual control manager  

In the individual control manager, you can 

perform the following actions for the 

processes currently selected in the tree 

structure using the usual shortcuts: 

 </> Hides all but the selected processes 

 <*> Hides the selected processes 

 <J> Hides all processes 

 <Delete> Deletes the selected processes 

 Combining shortcuts for visibility 

As soon as the mouse pointer is positioned on a process button in the right-hand 

menu, the shortcuts </> or <*> can be used to show or hide processes for this 

process type only. 

 

 

 

 

</> on Half lap, 

hides all processes 

except laps.  

< / > 
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From version 30 

(SP2024), pressing 

the </> key now on 

the Pocket button 

will also show all 

pockets in addition 

to the laps. 

Only repeated 

execution of the </> 

key on the Pocket 

button will only show 

pockets. 

 

 

 

With this procedure, any combination of processes can be added with </> and 

hidden with <*>. Only with a double execution: </>+</> or <*>+<*> are only 

the processes of this process type shown or hidden again.  

As usual, all processes are visualized by pressing <J>. Pressing <J> also 

interrupts the combining of visibilities. 

 

 Sorting and combining  

In addition to Status, the attributes 

Calculation locked?, Export? and Already 

exported? can now be used to sort and 

combine parts in the individual control 

manager. 

 

 Info window in the individual control 

The Subgroup attribute has been added to 

the info window of the individual control. 

The subgroup is often used as a further 

distinguishing attribute for production.   

< / > 

< / > 
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 Shortcut key for locking the parts in the individual 

control 

Locking a part in the individual control manager (lock 

symbol) prevents the machine data from being 

changed. Locking is useful after successfully checking 

the generated machine data. As of service pack 

2024, you can use the <AltGr+L> or <Ctrl+Alt+L> 

(US keyboard) shortcut key to Lock or Unlock a part 

in the individual control.  

This means you can if desired only use shortcut keys 

to check position by position in the individual control 

check: 

 

 <C> Trigger processing check  

 Check result 

 <AltGr+L> or <Ctrl+Alt+L> (US keyboard) 

Lock component 

 <Page down> Show next position...  

 

If a part is locked, you will receive an error 

message when executing an action that is 

locked as a result.  

In addition, functions that are not permitted are greyed out. 

 Lasso in individual control 

From version 30 (SP2024), machine processes can be activated with the lasso. As 

usual, the machining processes must be captured completely with the white lasso, 

whereas the red lasso enables activation by incomplete selection of the processes.  

<AltGr+L> 
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 Duplicating processes 

The Duplicate function has been added to the menu for processes in the 

Individual control manager. This duplicates the selected process operations.  

 

In a subsequent 

step, the duplicated 

processes can be 

modified. 

 

 

 

 

For example, it is 

possible to clean out 

rounded corners of a 

lap by first duplicating 

the lap and then 

assigning a different 

reference side to the 

duplicate process. 

 

 Switch process Ref. face for Dado/rabbet 

The Switch process Ref. face function is also available for Dado/rabbets, making it 

possible to process a dado/rabbet from a different side.   

As with the other processes, this function can be used via the context menu in the 

Individual control manager and via the <ALT+R> shortcut key with processes 

selected in the main window.  



News Version 30 (SP2024) 

 

 

2
0

2
4

4
0

 -
 c

ad
w

o
rk

 3
D

 Tool settings for contours 

A default tool can be stored for the available contour types. 

The tool query will no longer appear when manual 

processing is re-inserted. 

 

• Machine -> Calculation 

 Profiles as a silhouette 

The cross-section profile of finished profiles (circular beams, I-beams, hollow 

sections, steel sections, etc) can be calculated as a silhouette from the end face 

(Ref. 5) and transferred to BTLx as a silhouette (from BTLx2.2) or outline without 

processing. This 

information can be used in 

CAM systems for better 

collision control. 

To do this, in the machine 

configuration dialog activate the 

Calculate outline as Silhouette 

option under Options -> 

Silhouette as well as Use free 

reference side option under 

Options- >Reference side.  
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 Dovetail Flank angle 

The European dovetail is a special form of 

log home corner lap joint that is designed so 

that it can be produced using standard tools. 

This joint consists of a partial hip cut and a 

birdsmouth.  

The angles of inclination of the flashings and 

the notch must correspond to the set angle. As a rule, the angle is 15°.  

 

In the case of an American dovetail, a special tool with the set angle as the flank 

angle is required. The connection consists of a partial hip cut and an acute-angled 

notch.  

For both shapes, the flank angle set here must correspond to the angle in the 

configuration dialog Cut/Solder -> Log home... -> Dovetail settings dialog.  
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• Machine -> ... -> Export 

 Hundegger - Consistent BVX2.1 transfer  

The BVX2 interface for transferring machine data to Hundegger machines with 

CAMBIUM® has undergone continuous development in recent years. Specifications 

have also been changed in the process. Nevertheless, the machine control was 

quite tolerant and continued to read in BVX data correctly, sometimes with 

outdated descriptions.  

With the latest CAMBIUM® 

versions, Hundegger has started 

to check the BVX data 

received -very strictly for 

conformity. Components that do 

not fully comply with the 

specification are no longer 

accepted. We have therefore 

scanned the BVX export for 

inconsistencies and corrected 

existing errors. With the current 

cadwork versions, an export to 

the latest CAMBIUM®- versions 

should work smoothly. 

If you import an old bvx file into CAMBIUM® and find that components are 

classified as faulty, you must export this file again with a current cadwork version. 

 

 Dado/rabbet and front slot in BTLx 

In the BTLx interface 

description, there are 

no dado/rabbet and 

front slot operations. 

Although these are 

calculated in cadwork, 

they are exported as a 

lap or pocket.  

For BTLx exports to the CAM system Lignocam, the processes analysed as 

dado/rabbet or front slot are exported with an additional attribute:  

for dado/rabbet <UserAttribute Name="LC_PROCESS_TYPE" Value="AsDadoRabbet"/>  

for front slot <UserAttribute Name="LC_PROCESS_TYPE" Value="AsFrontSlot"/>.  

This means that the strategy tables for dado/rabbet and front slot can continue to 

be used in Lignocam.  

Faulty parts in CAMBIUM® 
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 Export internal thread to DSTV-NC steel 

Since version 30, the setting Display internal thread setting in the connnector axes 

dialog can be used to define for each zone independently whether the associated 

drilling should have an internal thread.  

This information is exported for Service Pack 2024 via the DSTV-NC interface. 

Please note that the nominal diameter must be specified in the case of an internal 

thread. 

The corresponding machining operation receives the designation internal thread  

from the machine data analysis and the nominal diameter (here M12) is displayed 

instead of the bore diameter.  

cadwork – DSTV-NC interface 

Steel CAM 



News Version 30 (SP2024) 

 

 

2
0

2
4

4
4

 -
 c

ad
w

o
rk

 3
D

• Machine -> Panel prefab... 

In version 30 (SP2024), the menu item Individual control has 

been renamed to the more appropriate term Composite control. 

 

 Open composite dialog  

When opening the composite control in panel prefab, the 

composite dialog is now always opened in version 30 

(SP2024). It is no longer relevant which part of an element is 

activated or selected. The first layer of the selected element 

is always opened in the composite dialog. 

However, it is essential that the machine data has been 

calculated so that all information is available for display in 

the composite dialog. If the data is not available, you will 

receive an error message and the composite control will not 

open. 

The dialog can be closed and reopened 

with the short cut key <Q>. 

 

 5-axis contour in panel prefab  

5-axis contour processing is enabled in Service Pack 2024 for 

machine exports in panel prefab production. The processing 

can either be picked up manually in a layer (frame layer, 

reference side or opposite side layer) on an additionally 

displayed part or it is calculated automatically as process of a 

and can then be moved to a layer.  
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 Panel prefab tools 

Tools are used for manual processing with the Rectangular MEP axes on the 

composite or for cutting, gluing and insulation in the panel analysis settings and 

can be created and configured in the tool dialog. Depending on the contour type, 

further properties are available in the additional attributes area. To create a new 

tool, the tool data for the desired processing type previously had to be loaded 

from the Userprofile using tool files or existing tools had to be copied. It was no 

longer possible to change the contour type at a later date. With cadwork version 

30 (SP2024), you have the option of creating tools for manual processing in the 

tool dialog with the New button and subsequently changing the contour type and 

thus the type of processing, for example from nail row to saw line. The available 

additional attributes of the selected contour type are automatically adjusted. 
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 Additional attribute Ignore protected area for manual nail rows  

For manually defined nailing rows using the Rectangular MEP axis, cadwork 

version 30 (SP2024) provides the additional attribute Ignore protected area in the 

tool dialog. 

If the value 1 is set for this option, the nailing row is not interrupted by a 

protected zone surface, even if the option Interrupt nailing in protected zone is 

set in the Panel analysis settings -> General. 

If the value 0 is set for this option, the row of nails is interrupted at protected 

zone surfaces as before. 
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 Consider lengthening/shortening end-type on elements in the framework 

Up to now, the lengthening/shortening end-type has not been taken into account 

when determining the length of the framework elements. As a result, framework 

elements are not exported in their true length. 

In version 30 (SP2024), you can specify whether the lengthening /shortening end-

type should be taken into account when exporting the framework elements.  

For this purpose, the new option Consider lengthening/shortening on framework 

elements has been added in the Panel analysis settings -> Extra settings. 

 

  



News Version 30 (SP2024) 

 

 

2
0

2
4

4
8

 -
 c

ad
w

o
rk

 3
D

Weinmann WUP export without consideration of lengthening/shortening end types 

on elements in the framework: 

 

Weinmann WUP export with consideration of end type lengthening/shortening of 

elements in the framework:  

*.wup file without end-type consideration loaded in Weinmann WupEditor Professional 

*.wup file with lengthening/shortening considered loaded in Weinmann WupEditor Professional 
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 Weinmann WUP 3.5 version 

In cadwork version 30 (SP2024) the export Weinmann WUP 

3.5 is available. When exporting with this interface version, 

the previous keywords for the machining operations lap 

(FRZ, FRY) and drilling (BOZ, BOY, BOX) are replaced by the 

keywords PAF PP and PAF MP respectively. The default value 

0 is assigned as the tool index so that the machine takes 

over the selection of the tool. 

A function key has been added to the Machine category for 

this output. 

 

 

 Insulation in the Panel analysis settings 

In version 30 (SP2024), it is possible to assign insulation 

elements that lie completely within the framework to a 

separate layer 0. For this purpose, the Insulation column has 

been added in the Panel analysis settings -> Name config. 

Elements that are assigned to this category and lie 

completely within the framework are exported in the 

reference side layer 0 or in the opposite side layer 0.   
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Whether an insulation element is assigned to reference side layer 0 or opposite 

side layer 0 can be determined by the alignment of its height axis. 

 

 

All other elements that lie within the framework and are not assigned to the frame 

column in Panel analysis settings -> Name config. are exported in a higher 

reference or opposite side layer.  

If you do not add any elements to the Insulation column in the Panel analysis 

settings -> Name config. tab, all elements that lie completely within the 

framework are exported in reference side layer 0 (PLI0) for the Weinmann WUP 

3.4 export as before.  

If you export with the new Weinmann WUP 3.5 export, it is necessary to configure 

the insulation in the Panel analysis settings -> Name config. in order to create a 

layer PLI0 or PLA0.  

PLI0 PLA0 
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• Machine -> Others... -> Docking saw 

Tenons cannot be milled on cross-cut 

systems. Instead, an off cut was previously 

calculated at the end of the tenon. For 

some docking saw systems (e.g. Stromab), 

these sections were problematic for tenons 

on bevel cuts, as the off cuts plane 

extends beyond the rough part.  

In version 30 (SP2024), a further off cut is 

added so that the part is always cut within 

the rough part. If the docking saw system 

supports V-cuts, the two cuts are 

combined into one V-cut. Tenons without 

backcut are cut along the tenon, tenons 

with backcut are cut at right angles. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Activate attribute -> Docking saw  

F-key function activates parts with right-angled off-cuts in order to filter them and 

decide whether they should be produced manually or on a docking saw system. 

Previously, it was not possible to execute the function without first calculating 

machine data. 

As of version 30 (SP2024), this function key can also be used without calculated 

production list numbers, without a machine license and without calculated machine 

operations. If machine data is already available, it is used to determine the relevant 

components. However, the calculation time of the function is extended if no machine 

data is available and again if no production list numbers have been calculated, as in 

this case each component must be examined individually.   
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• Shop drawing -> Piece-by-piece 

The text with the macro no. 

1107#nesting volume number from 

the layout file specifies the assigned 

numbers of the nesting volumes for 

the shop drawing export. Previously, 

the macro was only supported for 

element type panel. With service pack 

2024, element type beam is also 

exported with their assigned nesting 

volume number. 

 

Service pack 2024 introduces an additional function for the new shop drawing export 

of hip/valley rafters according to the method “Tracing lines all rough part edges”. 

Information on the roof slope, machine angle and reference to the location of the 

eaves is provided within the " Tracing lines all rough part edges method " method. 

The marking for the eaves is at the top left of the shop drawing export, while the 

note for the roof slope is at the top right. The values for the machine angle are 

traditionally located on the ridge and on the eaves of the hip/valley rafter.  

Macro in piece-by-piece - 2dc layout 

file 

Result exporting element type 

“Panel” 

Result exporting element type 

“Beam” 
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It should be noted that the positioning of the notes is fixed and cannot be positioned 

individually. 

To be able to customise the text formatting like font, color and size of the Eave and 

Slope information the text macro 6209# has to be used. This is a new macro in 

SP2024 and must be added manually to your existing piece-by-piece layout file as 

text Eaves / Slope with the name 6209# at the location shown below. 

Otherwise, default formatting will be used. 

 

This text marco has been added to most recent default layout files supplied by 

cadwork, which can be downloaded via Userprofile (user’s settings) -> Manage 

catalog/userprofile in the Piece-by-piece - Shop drawings register 
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• TIF file (*.tif) 

To create appealing rendered and shaded representations, the option Ambient 

Occlusion enabled can be selected in the Graphic options dialog, which can be called 

up via the left-hand menu. 

 

The respective display can be exported as a tif or jpg file via Export -> Image (*.tif, 

*.jpg). In previous version when using the Ambient Occlusion enabled option, the 

resolution factor has to be set to 1 for error-free export. This significantly limited the 

resolution of the generated image. 

 

This restriction was removed in Service Pack 2024, so that higher-resolution images 

can now also be exported. 

 

  



News Version 30 (SP2024) 

 

 

2
0

2
4

5
5

 -
 c

ad
w

o
rk

 3
D

With regard to the possible resolution factor, however, there are still restrictions 

resulting from the graphics card and graphics driver used.  

 

You can obtain detailed information on the restrictions via the Resolution info  

button in the image export save as dialog. 
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Files... -> DXF (*.dxf) 

 

The export to DXF files has been 

improved so that spline lines can 

now also be taken into account. 

The export from 3D is done in the 

DXF format AC1027 for AutoCAD 

2013 to AutoCAD 2017. 

 

 

 

 

 

• Files... -> IFC (*.ifc) 

News on exporting IFC files can be found in the IFC chapter. 
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❖ IFC 

 

➢ IFC import 

 

▪ Certification for IFC 4 - Reference View 

cadwork has received certification for the export of IFC 4 - Reference View from 

buildingSMART. This means that the software complies with the international standard 

IFC 4 and can therefore export models according to the specifications of 

buildingSMART.  

This certification ensures smooth interoperability and the exchange of models between 

different software applications that use the IFC standard. 

 

▪ Exchange objects 

A current Hoops version has been integrated into Service Pack 2024, which promises 

improvements in terms of both display quality and performance/stability. 

It is now also possible to visualize exchange objects in 2D planes. The elements are 

displayed as an intersection in the plane. 

Currently, the points of the visualized elements cannot be selected and used for 

construction.  



News Version 30 (SP2024) 

 

 

5
8

 -
 IF

C
2

0
2

4

▪ IFC Property Mapper and layer mapping 

You can use the property mapper to transfer/”map" attributes from the IFC file to the 

imported and converted elements in the 3D file. 

Previously, this mapping only worked for the properties of the IFC file, but now the 

information of the IFC layer can also be transferred for the elements of the 3D file. Like 

the properties, the IFC layer is also created as a cadwork attribute. 
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➢ IFC export 

 

▪ Export of multilayer wall - IfcMaterialConstituentSet 

We already introduced the option of exporting 

multilayer walls to IFC files in version 30.   

With the service pack 2024, you can export 

these multilayer walls not only with the 

IfcMaterialLayerSet, in which the layer definitions of a wall are included as informative 

text in the IFC file, but optionally also using the IfcMaterialConstituentSet.  

With this option, you can respond to the requirements of the project partner in an even 

more differentiated way and thus optimally support the subsequent planning steps. 

Wall imported on the left as a Material Constituent Set: The individual layers are 

available as materialized volumes including the wall rough volume. 

On the right, the same wall as a Material Layer set: the wall rough volume is generated 

as a volume, the information of the defined wall layers is defined as 

attributes/properties.  
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▪ Script-populated attributes in the export 

Attributes filled with scripts are taken into account when exporting in the 

cadwork3dproperties property set.  

 

This means that attributes and properties 

generated or influenced by scripts are exported in 

the standard property set of cadwork.  

This is particularly relevant for users who create 

complex attributes in their models using Python 

scripts. The automatically generated information is 

now also retained when exporting IFC files. 
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❖ Point cloud 

 

➢ General information 

As usual, you can only use the Point cloud interface via the corresponding license. on 

the following pages the new features are described. 

 

➢ Import 

In Service Pack 2024, you now have the option of dragging and dropping a Point cloud 

directly into your 3D file. Nothing else has changed in terms of import behaviour. The 

usual options via the menu or function keys are still available to you. 
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➢ Point cloud Manager  

The Point cloud Manager has been expanded to include the multiple selection function. 

Here you have the option of activating and controlling multiple sections.  

 

You can use <Ctrl>+(L) to 

individually pick planes, 

sections and slices with the 

mouse and add them to your 

selection. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can use <Ctrl+Shift>+(L) 

to select an entire portion of 

the list. Pick first and last 

Plane, Section or Slice with (L) 

and it adds everything in 

between to selection. 

  

1st (L) 

2nd (L) 
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➢ Clipping box  

The Zoom All behaviour of the clipping box has been adjusted so that when the clipping 

box is active, right-clicking (R) on Zoom All zooms to the geometry of the clipping box 

and not the geometry of the bounding box. 

 

Furthermore, the BIM attributes have been added to the clipping box. You now have 

the option of controlling the visibility of the clipping box via the storeys. 
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❖ Plugins 

 

The further development of functionality in cadwork is largely based on requests and 

suggestions that we receive from valued customers. 

Customer requests also include requirements that cannot be implemented at short notice 

or are so specific that they cannot be incorporated into the general range of functions. 

In both cases, the cadwork API can be helpful, which can be used to implement a specific 

functionality as a plugin. Although the plugin is not fully integrated into the cadwork 

functionality, it can use large areas of the existing functionality, access the data and 

manipulate it.  

 

The API offers the great advantage that its use can be learned by any cadwork user. After 

becoming familiar with the cadwork API, plugins can be developed independently to 

implement company-specific functionalities and thus customize cadwork. 

 

➢ General  

With cadwork version 30 (SP2024) it is possible to connect cadwork 3D directly to the 

execution of an API plugin. This is done by starting the 3d.exe with the argument 

"/PLUGIN=PluginName". This can be implemented using a batch file *.bat file, for 

example.  

As soon as cadwork 3D is started in this way and the 3D file has been loaded, the 

plugin defined in the argument is automatically started. It does not matter whether it is 

a plugin developed in C++ or Python. However, it is important that the specified plugin 

can be found under the corresponding name in the regular plugin directory in the 

userprofil_30 folder (...\userprofil_30\3d\API.x64). The following lines with the PATH 

and START instructions show how a batch file for starting cadwork with automatic 

execution of a plugin can look. 

 

PATH=C:\Program Files\cadwork.dir\exe_30\pclib.x64;C:\Program Files\cadwork.dir\exe_30\LxSDK.x64\bin\dlls;  

C:\Program Files\cadwork.dir\exe_30\LxSDK.x64\bin; 

 

 start /wait /max C:\Program Files\cadwork.dir\exe_30\3d.x64\3d.exe "C:Users\Users\Documents\TestFile.3d" 

/PLUGIN=example_plugin 

 

As can be seen, certain paths to the cadwork installation directory are defined first. This 

is necessary so that they can be found by cadwork 3D. The drive names and paths 

must be adapted to the cadwork installation on the system used.  
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➢ cadwork API - Help and discussion forum 

We would like to take this opportunity to point out that there is a possibility on the 

"GitHub" platform to ask questions about the use of our API and to exchange 

information with other users. Please use the following link: 

https://github.com/cwapi3d/cwapi3dpython/ 

 

A one-time registration is required to use the platform. You will find the "Sign up" 

button in the top right-hand corner. 

In the "Discussions" category, you can ask general questions about the use. To do this, 

you can open a new discussion using the "New discussion" button. You will then be 

shown various categories for this discussion. As soon as you have created a discussion, 

it is visible to other users. You can also participate in existing discussions at any time.  

 

If you notice any misconduct when using our API, you can report this in the "Issues" 

category. You can also submit requests for new functionalities here.  

https://github.com/cwapi3d/cwapi3dpython/discussions
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➢ BCF Manager – Connect to BIMcollab platform 

The extension of the BIM tools through the integration of the Software Development Kit 

(SDK) from BIMcollab as a plugin represents a step in the further development of the 

BIM tools in cadwork 3D. This extension enables a seamless connection to BIMcollab, a 

cloud-based platform that optimizes collaboration and communication in the field of 

BIM. In order to use the plugin, users need to create an account with BIMcollab. The 

first time they use it, they will be asked to create a login. On the cadwork side, the IFC 

Import/Export and BCF Manager licenses are required.  

 

The BIMcollab SDK plugin allows users to access BIMcollab functions and resources 

directly and integrate them into their existing BIM workflows. By utilizing these SDK 

functionalities, users can make their workflows more efficient as they can now interact 

directly with the BIMcollab platform without having to switch between different 

applications. 

 

This BCF Manager not only provides the ability to connect to the BIMcollab cloud, but 

also supports the use of local BCF XML files. This means that projects can be flexibly 

stored and edited both in the cloud and locally, depending on individual user 

requirements and preferences. 

This extension removes obstacles that previously hindered smooth communication and 

coordination between different project participants. 

 

▪ Connect with the cadwork BCF Manager or BIMcollab Zoom 

 

1. Open the cadwork BCF Manager or BIMcollab Zoom and click on the "Connect to 

BIMcollab platform" icon. 

2. In the "BIMcollab" field, enter the following information: 

a. join.bimcollab.com to connect to your free BIMcollab project. 

b. the URL of your private WebRoom (e.g. BIMcollab ) to connect to the private 

WebRoom. 

3. Click on "Connect" 

4. A new window will open. Enter your login details and click on "Log in". 

5. Select the project to which you want to establish a connection and click OK.  

http://join.bimcollab.com/
http://example.bimcollab.com/
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Source: https://helpcenter.bimcollab.com/portal/en/kb/articles/connect-from-bcf-managers-or-bimcollab-

zoom 

 

▪ BIMcollab help center 

Under the following link you will find the help center portal to report issues/bugs or log 

wishes/requests: 

https://helpcenter.bimcollab.com/portal/en/kb/articles/edit-and-comment-on-

issues#BIMcollab_Zoom_and_the_BCF_Managers 

 

  

https://helpcenter.bimcollab.com/portal/en/kb/articles/connect-from-bcf-managers-or-bimcollab-zoom
https://helpcenter.bimcollab.com/portal/en/kb/articles/connect-from-bcf-managers-or-bimcollab-zoom
https://helpcenter.bimcollab.com/portal/en/kb/articles/edit-and-comment-on-issues#BIMcollab_Zoom_and_the_BCF_Managers
https://helpcenter.bimcollab.com/portal/en/kb/articles/edit-and-comment-on-issues#BIMcollab_Zoom_and_the_BCF_Managers
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➢ Joinery Tool Center (JTC) 

The plugin is updated independently of the annual cadwork versions. This has led to the 

release of JTC version 3 in December 2023, which contains further improvements and 

changes. 

 

▪ Changes to the design 

Based on customer feedback, small adjustments were made to the design and 

structure. 

 

▪ New "Step back" function  

Previously, processes created by the JTC had to be deleted manually. Now it is possible 

to undo individual processing steps. The "Step back" function <AltGr>+<Z> can be 

used to undo any action performed in the plugin without changing previous calculation 

results. 

 

▪ Hardware configurator database  

The hardware configurator database has been adapted. 

Manufacturer configurations can now be selected and set directly. 

We have also added many typical furniture fittings to the selection 

options. You can change and save these according to your own requirements. You can 

also add your own catalog elements to the hardware configurator. 

 

▪ Save & load default settings  

The settings selected by the user in the various dialogs can be saved and loaded as 

default settings. Defining default settings speeds up working with JTC, as the dialogs 

are always opened with the user-specific settings. 
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❖ Tools 

 

➢ OptiPanel 

Version 2.10.x of the OptiPanel panel nesting optimization was made available for the 

delivery of cadwork version 30. Version 2.12.x will be delivered with Service Pack 2024, 

if required licence bit is active. 

Numerous bug fixes and improvements have been implemented during this year. You 

can obtain an overview of all bugfixes and improvements at any time in OptiPanel itself 

via Help -> Release notes. 

OptiPanel – 4 step nesting optimization OptiPanel – Step 4 Results 
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Below a list with a summary of key improvements: 

 

▪ It is possible to undo or redo up to 50 steps. Previously, there was a limit of ten steps. 

▪ The optimization algorithm for polygonal parts and free rotations has been updated and 

offers improved performance and new parameters. 

▪ Support for additional attributes to keep panels with identical attributes together (block 

raw panel on attribute).  

▪ It is possible to define an edge distance per edge for each nesting volume to position 

the panels to be nested. 

▪ In the table of nesting volumes, it is possible to edit the values for the maximum length 

and the increment for the automated creation of new nesting volumes. 

▪ The material costs can be predefined for lineal meters and square meters. 

▪ It is possible to import the nesting volume list from any OptiPanel project file. 

▪ There is a warning message if OptiPanel cannot process imported geometry 

information. 

▪ In the nesting volume and panel tab, previously selected nesting volumes and panels 

can be duplicated using the Duplicate button. 

▪ Duplicating panels may only be used if OptiPanel is used without a connection to 

cadwork. When importing panels from cadwork, duplicating these panels leads to an 

incorrect reimport of the optimization results back into cadwork, as the number of 

panels is no longer consistent.  
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➢ BIMteam – cloud platform 

 

▪ General information 

Version 23 introduced the WebViewer based on HTML5 files as a platform-independent 

visualization option for cadwork 3D models. The WebViewer is a helpful tool for 

providing 3D models to customers or partners. Over time, however, we have realized 

that the functionality has become increasingly limited due to manufacturer and web 

browser restrictions. The background to this is that HTML files can be circulated with 

malicious scripts and therefore represent a considerable security risk. HTML files 

exported from cadwork 3D are also very large, which makes sending them by email 

very cumbersome. For these reasons, we introduced BIMteam with version 30. The 

local WebViewer export will continue to be supported, but further developments of the 

viewer will only be developed for BIMteam. 

 

▪ Overview 

BIMteam is a cloud platform with an integrated WebViewer and constantly evolving 

features. You can use the platform to collect and manage your project-relevant files in 

one place. BIMteam is made available on a server infrastructure managed by cadwork. 

The platform can be accessed via any web browser. Register to test the platform free of 

charge at https://bimteam.cadwork.ch/. You can find a step-by-step video on our 

YouTube channel. BIMteam is already being used by some of our clients, mainly in the 

civil engineering field. It is still in the development phase as new functions are 

constantly being added. You can find an overview of the current status of the BIMteam 

solution on the following pages. 

  

https://bimteam.cadwork.ch/
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To be able to use BIMteam and its range of functions, you must first register, which is 

free of charge. BIMteam offers packages that can be purchased on a monthly basis as 

required. The "Free" package can be used free of charge and is available to every 

cadwork user after registration. There are four other packages ("Tiers"), each of 

which allows more users, storage space and projects to be managed. Your selected 

tier can be extended with additional functionalities, e.g. for the WebViewer, if 

required. A detailed list of the tiers and their extensions can be found here. 

 

▪ Structure 

 

• Organization  

BIMteam allows you to create and manage multiple organizations. Organizations can 

contain projects, users and payment information for corresponding license packages. 

Users within an organization can be assigned to different teams. Access 

authorizations are managed by administrative users. 

 

• Projects  

You can store associated files under the projects. BIMteam not only supports 

cadwork files (*.3d, *.2d or *.cwlm), but also files that are important for the project, 

such as *.ifc, *.dxf or *.dwg or *.pdf. These files can be made available to 

customers and other stakeholders using shared links. The viewer opens in the 

browser as usual via the link. The administrator can set which authorizations the 

individual users or teams have.  

https://bimteam.com/index.php/en/bestellen-3
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▪ Exporting viewer files from cadwork 3D to BIMteam  

This point describes the function of exporting from the 3D as a viewer file to the 

platform, i.e. the area of the platform that is similar to the local WebViewer. 

 

 

Viewer files can be uploaded directly from the cadwork 3D to a project on the platform. 

This is done via Export -> Files... -> BIMteam (cloud upload) 

 

Under Login, you can log in to the BIMteam server and select the project to which you 

want to upload data. The associated organization is now also displayed in the selection. 
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Similar to the already familiar WebViewer export, you can also define a hierarchy for 

the exported file under General settings. 

 

Click on BIMteam (cloud upload) to upload the file in *.bte format to the selected 

project. 

 

After the upload, a new window opens in which you have the following options: 

You can generate a link to send directly in the dialog without having to switch to the 

platform. After clicking on the Share link button, the link will be displayed. This can be 

saved to the clipboard using the copy symbol and pasted into an email, for example, 

using <Ctrl+V>. The Open BIMteam button takes you to the project overview on the 

BIMteam platform and the Open model button opens the project in the viewer. 
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Click on the QR code to generate the corresponding QR code in the clipboard. You can 

insert this into any file with <Ctrl+V>. 

 

In the BIMteam web browser view, you will find the uploaded *.bte file in a subfolder of 

the project called cadwork 3D Uploads. The viewer files can also be opened in the 

integrated viewer here by double-clicking. The same functions are available in this 

viewer as in the local WebViewer files. 
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▪ File versions 

If the export is triggered again in the same file, the link does not change. Instead, a 

new version of the file is uploaded. This means that the link can always be used to 

open the current version of the viewer file.  

The versions can be viewed and managed on the platform by right-clicking (R). 

 

 

 

▪ Sharing a file on the BIMteam platform 

To be able to share your project data, you need to generate a share link via the context 

menu on the BIMteam platform. You can access this context menu by right-clicking (R) 

on your file. Anyone who has access to this link will be directed to the file via the 

viewer. 
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▪ Via Add -> Upload file, files such as cadwork 3D or 2D files, 

graphics, PDF or other file formats can also be uploaded via 

the BIMteam web browser portal. 

Many standard formats can be viewed via the integrated 

WebViewer. These include most graphic formats or the PDF 

format. 

Depending on your authorization, you can view, delete, 

upload or download any files. 

 

 

 

 

▪ New features since the release of version 30 

 

• Pin notes (Part of “Pro” Extension): 

Enhance the presentation of your 3D model using pins to draw attention to specific 

areas. The pins can be added in five different colors, so you can differentiate 

between different points of interest. 

Each pin can be given a title, an optional description and left-click (L) on images and 

files with files. 
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By clicking on the Location button, each pin must be assigned a "Location", which is 

selected with a point in the 3D model and defined with Submit. 

Appropriate access rights are required to create pins. Once pins have been created, 

you can share them with other people.  
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• BIMteam app 

The BIMteam app for Windows is now available. Discover the extended functionality 

with exclusive support for the file formats *.dwg, *.dxf and *.dgn. The application 

can be downloaded from our website www.bimteam.com under the menu item 

"Download". 

 

• Dark and light theme for BIMteam viewer 

You can customize the appearance of the platform by choosing between a light and a 

dark theme in your profile settings. This setting is now also applied to the BIMteam 

viewer. 

 

• New grid layout with project image in the Projects overview 

In the project overview, you can choose between two different layouts using the 

layout button: Grid or List layout. 

https://www.bimteam.com/index.php/en/
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To specify a project image, go to the project settings and select an image to be 

displayed in the grid layout. 

 

• Improved model structure and property sets for the BIMteam viewer 

The updated model structure and property sets result in shorter loading times and 

improved user-friendliness. The design has been improved so that navigation is now 

even more intuitive. With a right-click (R) on a hierarchy level, you can select all 

elements within a level and make them reappear with Show all. 
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• Dimensioning tool - Normal measurement (Part of Basic extension) 

The dimensioning tool, which can be used to measure the normal distance between 

two surfaces has been added to the BIMteam viewer.  

 

 

• B-scene editing 

With a B-scene, up to 50 models can be combined in one "scene".  

B-scenes can now also be edited after initial creation. To do this, right-click (R) on 

the desired B-scene and select the Edit option in the drop-down menu to add, delete 

or arrange the models in a desired order. 
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• New "Issues" feature (Part of “Pro” extension) 

You can now create issues within a project and discuss them with your team 

members. You will find the issues in the left-hand menu bar in your project. When 

you open it, you will get an overview of all open issues. 

You can create a new issue by clicking on the New issue button and adding a title 

and an optional description. 
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Once created, you and other team members can add comments. 

Once an issue has been completed, it can be closed and automatically moved to the 

Closed issues. 

To be able to create and edit issues, you need at least Editor- permissions. 

 

• New Shared button 

The Shared button takes you to a list of projects. These projects are visible because 

someone has shared a model or a B-scene with you via a link. If you double-click on 

one of these projects, you can navigate to the shared model. As you have received a 

share link, your access to the individual models within the shared projects is 

restricted. 
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• B-scenes linked in the model detail 

If you right-click (R) on a model and select Model detail from the drop-down menu, 

you will get a list of B-scenes that use this model.  

 

In our latest version, you have the option of opening the corresponding B-scene 

directly from the model detail. Alternatively, you can also navigate to the folder of 

the B-scene by clicking on the folder link. 
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• Activating or deactivating viewer extensions and measurement function for certain B-

scenes 

When you create or edit a B-scene, you can now restrict some of the tools that 

appear in the Viewer toolbar. Select Extensions from the Restricted Extensions drop-

down menu, the extensions you select will be disabled for that specific B-scene. You 

can also decide whether you want to activate or deactivate the measurement 

function. 

• Customize the viewer logo (Part of “Pro” extension) 

To customize your project, you can integrate a logo into the BIMteam viewer. This 

logo is displayed in the bottom right-hand corner (see illustration) and can be 

configured in the project settings under Project logo. This function is only available if 

you have purchased the "Pro" extension.  
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• Improved point selection with "crosshair" function for tablets (Part of “ToField” 

extension) 

We have improved point selection with a new "crosshair" feature designed 

specifically for tablets. This improvement provides a more accurate and user-friendly 

way to select points on the screen. 

• New Surveying UI (User interface): (Part of “ToField” extension) 

Simplified interface, optimized workflows for an improved user experience 

Our new user interface combines routines with optimized workflows and instant 

accessibility.  
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• Introduction of Polyline: Improved stakeout functionality 

We have extended our stakeout functionality by point, line and area to include 

stakeout by polyline. 

This function is only available in the new user interface. 

 

• Model structure - Behaviour refined 

When you select an element (L), it is no longer automatically displayed in the model 

structure. Instead, the element and folder names have been added to the top of the 

properties window to provide clear navigation hints. If you want to find the element 

in the model structure, simply right t-click (R) on it and select Model Structure from 

the drop-down menu. 

• Improved search functionality for the BIMteam viewer 

The search function now not only highlights the elements you are looking for, but 

also opens them directly.  
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• Multiple selection in the BIMteam viewer 

With the familiar combination of <Ctrl> (<CMD> on Mac) and model selection, you 

can now activate multiple elements. This function is available both in the model 

structure and in the 3D model as well as a combination. 

 

 

 

 

  

Selection in model structure 

Selection in 3d model 
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❖ Appendix 

 

➢ Keyboard options 

 

▪ <Ctrl+Tab>Reverse activation  

If elements are already active, the function swaps the activation for all visible elements. 

All active elements are deactivated and the elements that are not active when the 

function is called are activated. 

 

➢ Function keys F1-F12 

 

▪ Activate attribute 

• Docking saw plus(see page 51) 

• Activate parts – mitre off cuts only (see page 51) 

• Activate parts – mitre and bevel off cuts(see page 51) 

 

▪ Machine 

• Panel prefab... -> Weinmann WUP 3.5 

 

 

 


